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Лабораторна робота 1 

Знайомство з структурою ГІС. Початок роботи в Saga.gis 

Завантаження, оформлення та зберігання растрових карт 

 

Геоінформаційні системи (ГІС) - це набір технологій і програмних 

засобів, що забезпечують загальні методи організації, зберігання, обробки, 

аналізу та виведення просторової і пов'язаної з нею описової інформації. 

Географічна інформація може надаватися у вигляді наборів географічних 

даних (баз просторових даних), які моделюють географічне середовище за 

допомогою простих узагальнених структур даних. Основними елементами 

бази просторових даних є:  

Реальний об'єкт - явище навколишнього світу, яке не може бути більше 

поділене на явища того ж самого типу (ліс, річка, гора, місто, промисловий 

об’єкт).  

Просторовий об'єкт - цифрове представлення цілого або частини 

реального об'єкта, тобто цифрова модель об'єкта місцевості, яка містить 

інформацію про його місцезнаходження і набір властивостей, характеристик, 

атрибутів (як в числовому, так і текстовому вигляді).  

Метод цифрового представлення просторових об'єктів змінюється у 

залежності від базового масштабу і ряду інших чинників. Існує два підходи 

до подання просторових об'єктів у цифровому вигляді: растровий і 

векторний. 

 

Хід роботи 

Перейдіть за посиланням на офіційний веб-сайт ГІС SAGA  

http://www.saga-gis.org/ та для завантаження актуальної версії натисніть на 

елемент Downloads. Станом на 5.07.2022 доступна для завантаження версія 

SAGA 8.2.2 [1]. 
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Покрокова інструкція завантаження 

і встановлення програми у  

[2, С. 29-32] 

Елементи графічного інтерфейсу Saga.gis: 

 

Завантажити растрові дані (висотну модель) можна на сайті SRTM Tile 

Grabber http://dwtkns.com/srtm/ 

Для цього необхідно виділити квадрат необхідного вам регіону і натиснути 

Download GeoTIFF (зображення з географічною прив’язкою). 

 

 

Відскановані карти можна завантажити на сайті https://satmaps.info 

Для цього натисніть Перейти до пошуку топографічних карт. На карті 

виберіть необхідний вам регіон і натисніть Перегляд доступних карт.  
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Наприклад, для міста Ужгород знайдено карти різного масштабу: 

 

 

 

Оберіть і натисніть одну із них. Зображення карти відкриється у новій 

вкладці. Щоб завантажити скан карти, натисніть map image download m-34-129. 

Для пошуку і завантаження космічних кольорових знімків перейдіть за 

посиланням Natural Earth - http://www.naturalearthdata.com/ 

Перейдіть у розділ Downloads, Medium scale data, Raster 

 

Після цього натисніть Cross-blended Hypsometric Tints→Cross Blended 

Hypso with Shaded Relief and Water→Download small size  

Створіть папку Лаб1 і перемістіть завантажені архіви та файли у цю папку: 
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 Топографічна карта 

 Архів космічних знімків 

 Растрова карта (карта висот) 

 

Для початку роботу запустіть SAGA.gis 

Розархівуйте папку srtm. 

У меню SAGA.gis виберіть File→Open→Лаб1→srtm→srtm_XX_XX.tif 

У закладці Data з’являється завантажений файл 

 

Щоб переглянути зображення, двічі 

натисніть на нього. Проведіть курсором по 

зображенні, зверніть увагу, як змінюються 

координати X, Y та Z під зображенням. 

Проаналізуємо вміст закладки Settings у вікні властивостей: Змініть назву 

шару у полі Name на Uzhhorod. Натисніть Apply.  

 

Змінити прозорість карти можна у полі Transparency. 

Змінити кольорову 

схему (за 

замовчуванням 11 

colors) карти можна у 

полі Histogram 

Stretch→Colors→…→ 
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У випадаючому вікні виберіть гамму синій→світло-

жовтий→коричневий (topography). Натисніть Okay і потім Apply. 

Синій колір відповідає низовині, а коричневий – височині. Для більшої 

реалістичності – у вікні Colors у трьох верхніх полях - замінимо синій колір 

(зліва) на зелений, а коричневий (справа) - на білий (вкриті снігом вершини 

гір). 

 

Натисніть Okay і потім Apply. 

 

У вкладці Legend можна побачити 

відповідність кольорів висотам над рівнем 

моря. 
 

Збережіть карту: наведіть курсор на назву шару 

Uzhhorod, натисніть правою кнопкою миші і у 

діалоговому вікні виберіть Save as. Файл 

Uzhhorod.sgrd збережіть до папки Лаб1/srtm. 

 

 

Збережіть проект File→Project→Save Project as з назвою Lab1 до папки 

Лаб1. 

Закрийте карту.  

Тепер завантажимо відскановану карту. 
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У меню SAGA.gis виберіть File→Open→Лаб1→100K-m34-129.gif 

Недоліком цієї карти є те, що вона не має географічної прив’язки. 

Переконатись у цьому можна, натиснувши вкладку Description у вікні 

властивостей. Навпроти поля Projection є запис Undefined Coordinate 

System – невизначена система координат. 

Закрийте карту без збереження змін. 

Завантажимо космічний знімок вибраного регіону. Для цього спочатку 

потрібно вилучити файли з архіву HYP_50M_SR_W.  

У меню SAGA.gis виберіть File→Open→Лаб1→HYP_50M_SR_W→ 

HYP_50M_SR_W.tif 

Подвійним натисканням на назву карти  у вікні управління відкриємо 

карту у вікні перегляду: 

 

Для збільшення необхідного регіону, використовуємо інструмент Zoom.  

Щоб повернутись до вихідного вигляду карти, натисніть Zoom to Full 

Extent на панелі інструментів. 

Контрольні запитання: 

1. Дайте визначення понять «інформація», «інформатика», 
«геоінформатика». 

2. З якими науками пов’язана геоінформатика?  
3. З яких компонентів складається будь-яка геоінформаційна система?  
4. Охарактеризуйте історію розвитку географічних інформаційних систем 

у світі.  
5. Охарактеризуйте застосування ГІС-технологій в Україні та світі. 
6. Назвіть основні елементи графічного інтерфейсу Saga.gis 
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Лабораторна робота 2 

Додавання векторних даних у середовища Saga.gis 

 

Векторна і растрова моделі. ГІС може працювати з двома типами даних - 

векторними і растровими. У векторній моделі інформація про точках, лініях і 

полігонах кодується і зберігається у вигляді набору координат X, Y. Місце 

розташування точки (точкового об'єкта), наприклад бурової свердловини, 

описується парою координат (X, Y). Лінійні об'єкти, такі як дороги, річки або 

трубопроводи, зберігаються як набори координат X, Y. Полігональні об'єкти, 

типу річкових водозборів, земельних ділянок або областей обслуговування, 

зберігаються у вигляді замкнутого набору координат.  

Векторна модель особливо зручна для опису дискретних об'єктів і менше 

підходить для опису неперервних змінних властивостей, таких як типи 

грунтів або доступність об'єктів. Растрова модель оптимальна для роботи з 

безперервними властивостями. Растрове зображення являє собою набір 

значень для окремих елементарних складових (осередків), воно подібно 

відсканованої карті або картинці. Обидві моделі мають свої переваги і 

недоліки. Сучасні ГІС можуть працювати як з векторними, так і з растровими 

моделями. 

 

Векторні дані у ГІС зберігаються у вигляді шейп (shape) файлів. 
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Хід роботи 

Для пошуку і завантаження векторних даних перейдіть за посиланням 

Natural Earth - http://www.naturalearthdata.com/ 

Перейдіть у розділ Downloads, Medium scale data, Cultural 

Завантажимо шейп-файли: 

Кордонів країн - Admin 0 – Countries Download countries  

Міст - Populated Places Download populated places  

 

Перейдіть у розділ Downloads, Medium scale data, Physical 

Завантажимо шейп-файли: 

Річок - Rivers, Lake Centerlines Download rivers and lake centerlines  

Озер - Lakes + Reservoirs Download lakes  

 

Створіть папку Лаб2 і перемістіть завантажені архіви у цю папку: 

 

 Архів кордонів країн 

 Архів озер 

 Архів міст 

 Архів річок 

Розархівуйте завантажені файли. 

У меню SAGA.gis виберіть File → Open→ 

Лаб2→ne_50m_admin_0_countries→ ne_50m_admin_0_countries.shp 

 

Проаналізуйте вміст вкладки 

Descriptions у вікні властивостей. 

Відкрийте таблицю атрибутів шару 

ne_50m_admin_0_countries. Для цього 

виділіть шар у вікні управління і правою 

кнопкою миші викличте діалогове вікно, у 

якому виберіть Attributes→Show.  
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У результаті, у вікні перегляду відкриється таблиця з атрибутивними 

даними шару ne_50m_admin_0_countries 

 

Дослідіть, скільки рядків і стовпчиків містить таблиця. Знайдіть рядок, що 

відображає дані про Україну. Яку інформацію містить таблиця? 

Закрийте таблицю. 

Подвійним натисканням відкрийте шар ne_50m_admin_0_countries.shp 

На карті, що відкрилась, використовуючи інструмент Zoom, знайдіть 

Україну. 

Поверніться до повного охоплення карти, використовуючи інструмент 

Zoom to Full Extent. 

У вікні властивостей у вкладці Settings змініть стиль заповнення полігонів 

Fill Style → Backward Diagonal. Також змініть забарвлення ліній кордонів з 

чорного на синє: Outline→Color→Blue. Збільшіть товщину ліній: 

Outline→Size→2. Натисніть Apply. 

Знов змініть стиль заповнення полігонів Fill Style → Opaque. Змініть 

забарвлення наповнення полігонів з червоного на жовтий Single Symbol 

→Colors→ Yellow. Натисніть Apply. 

Використовуючи інструмент Zoom, збільшіть ділянку карти, де є Україна. 

Інструментом Action (чорна стрілка на панелі інструментів) виділіть полігон 

Україна. Змініть забарвлення контуру полігону і самого полігону у секції 

Selection (вікно властивостей). 
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Відкрийте таблицю атрибутів і знайдіть рядок Ukraine. У таблиці 

атрибутів виділіть рядок Poland, натиснувши один раз на номер відповідного 

рядка. Які зміни відбулись на карті? 

Для наближення чи пошуку виділеного полігону, на панелі інструментів 

натисніть Zoom to Selection. Знов відкрийте таблицю атрибутів і виділіть 

рядок Angola (або будь-яку іншу країну). Поверніться до карти і натисніть 

Zoom to Selection. 

Щоб зняти виділення, натисніть у будь-якій точці океану. 

Поверніться до повного охоплення карти (Zoom to Full Extent). 

Тепер завантажте шари озер, міст та річок:  

У меню SAGA.gis виберіть  

File→Open→Лаб2→ne_50m_lakes→ne_50m_lakes.shp 

File→Open→Лаб2→ne_50m_populated_places→ne_50m_populated_places.shp 

File→Open→Лаб2→ne_50m_rivers_lake_centerlines→ne_50m_rivers_lake_cent

erlines.shp 

 

Таким чином, у вікні управління можна побачити 4 

векторні шари: 2 полігональні, 1 точковий та 1 лінійний. 

Щоб відобразити завантажені шари на карті, їх потрібно 

до неї додати. 

Для цього двічі натисніть на 

кожен шар – у вікні перегляду 

з’явиться діалогове вікно з 

можливістю обрати, до якої карти 

(якщо відкрито декілька) додати 

обраний шар. 
 

  

Для зручності перегляду у вікні властивостей кожного із шарів можна 

змінювати забарвлення чи розмір об’єктів. 
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Знову наблизьте полігон Україна і виділіть його.Точки на карті – це 

населені пункти. Підпишемо їх назви. Для цього відкрийте таблицю 

атрибутів шару ne_50m_populated_places. Знайдіть стовпчик, у якому 

записано назви усіх міст - Name. Поверніться до карти. У вікні властивостей 

у розділі Labels→Attributes виберіть назву атрибуту Name. Натисніть 

Apply. Тепер усі населені пункти – підписані. 

Для зручності перегляду змініть шрифт і розмір підписів у відповідному 

розділі властивостей  

Аналогічно можна підписати назву країни. У вікні управління виділіть шар 

ne_50m_admin_0_countries, а у вікні властивостей у розділі 

Labels→Attributes виберіть назву атрибуту Name. Натисніть Apply. 

Збережіть проект File→Project→Save Project as з назвою Lab2 до папки 

Лаб2. Закрийте карту.  

 

Контрольні запитання: 

1. Які ресурси використовують для завантаження векторних даних? 

2. Які моделі даних називають векторними топологічними і векторними 

нетопологічними? Поясніть різницю між ними. 

3. Які просторові об’єкти позначають у вигляді точок, ліній, полігонів? 

4. Які дані називають атрибутивними? Наведіть приклади. 

5. Які функції та можливості має вікно властивостей інтерфейсу Saga.gis? 
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Лабораторна робота 3 

Створення та експорт карти з використанням ресурсу Natural Earth 

 

Усі географічні карти складають у певних картографічних 

проекціях. Картографічна проекція – це математично визначений спосіб 

зображення земної поверхні на площині (карті). Реальна земна поверхня 

дуже складна і не відповідає жодному геометричному тілу. Щоб відтворити 

цю поверхню на карті, спочатку її відображають на математично правильній 

фігурі (кулі), а потім переносять це зображення на площину, ніби 

проектуючи його. 

Картографічних проекцій існує багато, їх об’єднують у групи. Насамперед 

проекції поділяють за видом допоміжної поверхні, яка використовується при 

переході від кулі до площини карти. Розрізняють проекції циліндричні, коли 

проектування з кулі здійснюється на поверхню циліндра, конічні, коли 

допоміжною поверхнею служить конус, і азимутальні, коли проектування 

ведеться безпосередньо на площину. 

 

 

На картах враховується кулястість земної поверхні, однак передати дійсну 

форму нашої планети вони не можуть. Карти спотворюють поверхню Землі 

та обриси окремих географічних об’єктів. Картографічні спотворення — це 

порушення геометричних властивостей об’єктів земної поверхні (довжини 

ліній, кутів, форм і площ) під час їх зображення на карті. Про характер і 
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ступінь спотворень на карті можна скласти уявлення, порівнюючи 

картографічну сітку з градусною сіткою глобуса. 

За характером спотворень розрізняють рівнокутні, рівновеликі та довільні 

проекції. У рівнокутній проекції без спотворень передаються напрямки, а 

форма і площа об’єктів деформуються. Таким чином, на різних ділянках 

карти масштаб відрізняється. Виконані цим способом карти застосовують для 

прокладання маршрутів повітряних і морських суден. Карти, виконані з 

допомогою рівновеликої проекції, використовуються для визначення 

розмірів материків, океанів, держав. Вони точно передають площу об’єкта, 

але деформують напрямки, а також і форму об’єкта. 

Отже, системи координат визначають, як об’єкти на карті співвідносяться з 

реальними об’єктами на поверхні земної кулі за допомогою координат. А 

картографічні проекції визначають, яким чином еліпсоїд Землі розгортається 

на площину. 

Проекція Меркатора (UTM, от англ. Universal Transverse Mercator) 

Проекція Меркатора - це рівнокутна циліндрична проекція, яка спочатку 

була створена для відображення точних показань компаса в морських 

подорожах. 

Меридіани представлені прямими вертикальними лініями, паралельними 

одна одній та розташованими на однаковій відстані, при наближенні до 

полюсів йдуть у нескінченність. Лінії широти є горизонтальними прямими 

лініями, перпендикулярними меридіанам; довжина ліній широти та екватора 

однакова, інтервал між ними збільшується у напрямку полюсів. Полюси 

проектуються в нескінченність і не можуть відображатися на карті. Градусна 

сітка проекції симетрична щодо екватора та центрального меридіана. 

Спотворення площі збільшуються у напрямку до полярних регіонів. 

Наприклад, хоча Гренландія становить лише одну восьму від розміру 

Південної Америки, у проекції Меркатора вона виглядає більше за Південну 

Америку. Значення спотворень уздовж певної паралелі залишаються 

постійними, вони симетричні щодо екватора та центрального меридіана. 
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Mercator projection 2016. Britannica Academic. Retrieved 5 August 2016, from 

http://academic.eb.com.proxy.lib.chalmers.se/levels/collegiate/article/52078 

 

Хід роботи 

Для пошуку і завантаження даних перейдіть за посиланням Natural Earth - 

http://www.naturalearthdata.com/ 

Перейдіть у розділ Downloads, Large scale data, Raster, Natural Earth I. 

Завантажимо зображення Землі з рельєфом та водними об’єктами:  

Natural Earth I with Shaded Relief and Water Download large size  

Збережіть архів у папаку Лаб 3 та розпакуйте його. 

 Завантажимо полігони країн: Downloads, Large scale data, Cultural, 

Admin 0 – Countries Download countries . 

Збережіть архів у папку Лаб 3 та розпакуйте його. 

 

 Також завантажимо міста: Downloads, Large scale data, Cultural, 

Populated Places Download populated places . 

Збережіть архів у папку Лаб 3 та розпакуйте його. 

 

 Також завантажимо дороги: Downloads, Large scale data, Cultural, 

Roads Download roads . 
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Збережіть архів у папку Лаб 3 та розпакуйте його. 

 

У розділі Downloads, Large scale data, Physical завантажимо 

Ріки Rivers + lake centerlines Download rivers and lake centerlines  

Озера з водосховищами Lakes + Reservoirs Download lakes  

Збережіть архіви у папку Лаб 3 та розпакуйте їх. 

 

Таким чином, у папці Лаб3 є 6 папок: 

 

 Кордони країн 

 Озера 

 Міста 

 Ріки 

 Дороги 

 Зображення Землі 

 

Спочатку завантажимо у середовище Saga.gis растрову підкладку карту 

Землі. Для цього у меню SAGA.gis виберіть 

File→Open→Лаб3→NE1_HR_LC_SR_W→NE1_HR_LC_SR_W.tif 

Подвійним натисканням по растровому шару у вікні управління відкрийте 

карту у вікні перегляду.  

Знайдіть на карті Україну та збільшіть відповідний фрагмент. Для 

покращення якості зображення (зменшення пікселізації), у вікні властивостей 

у розділі Display→Resampling замініть Nearest Neighbour на Bilinear 

Interpolation. Натисніть Apply. 

 

Завантажимо у середовище Saga.gis 5 шейп-файлів з відповідних папок:  

 полігони кордонів країн:  

File→Open→Лаб3→ne_10m_admin_0_countries→ne_10m_admin_0_c

ountries.shp 

 озера:  
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File→Open→Лаб3→ne_10m_lakes→ ne_10m_lakes.shp 

 ріки:  

File→Open→Лаб3→ne_10m_rivers_lake_centerlines → 

ne_10m_rivers_lake_centerlines.shp 

 міста:  

File→Open→Лаб3→ne_10m_populated_places→ne_10m_populated_p

laces.shp 

 дороги:  

File→Open→Лаб3→ne_10m_roads →ne_10m_roads.shp 

 

У вікні управління перейдіть до закладки Maps. Перейменуйте карту. Для 

цього у вікні властивостей у розділі Settings→Name змініть назву карти на 

Ukraine.  

Поверніться до закладки Data. Додайте завантажені шари до карти 

Ukraine. Для цього по черзі двічі натисніть на кожен шар і в діалоговому 

вікні виберіть Ukraine. 

Для зручності перегляду відредагуйте у вікні властивостей кожного шару 

забарвлення, товщину ліній і розмір точок. Для полігонів кордонів країн 

встановіть стиль заповнення Display→Fill Style→Transparent. 

Для шару міста у розділі Labels виберіть атрибут Name. Натисніть Apply. 

Таким чином, на карті з’являться підписи назв міст. Аналогічно можна 

додати назви озер, річок і країн. 

Створення карти на даному етапі можна вважати завершеним. Для 

збереження зображення і можливості його експорту (друк, вставка у текст) на 

панелі інструментів натисніть Map→Save as Image…→Лаб3 з назвою 

Ukraine. Через провідник первірте вміст папки Лаб3, знайдіть і відкрийте 

файл Ukraine.png. 
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Також відкрийте і перегляньте файл Ukraine_legend.png. 

Збережіть проект File→Project→Save Project as з назвою Lab3 до папки 

Лаб3. Закрийте карту.  

 

Контрольні запитання: 

1. Дайте визначення картографічної проекції. Назвіть їх основні типи. 

2. З якою метою використовують різні картографічні проекції? 

3. Чому на географічних картах виникають спотворення? Охарактеризуйте 
основні типи картографічних спотворень. 

4. Проекція Меркатора – суть і застосування. 

5. Які дані можна завантажити, використовуючи ресурс Natural Earth?  
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Лабораторна робота 4 

Робота з растровими даними 

 

Растрова модель - це цифрове представлення просторових об'єктів у 

вигляді сукупності осередків растра (пікселів) з присвоєними їм значеннями 

атрибута. Кожному осередку растрової моделі відповідає однаковий за 

розмірами, але різний за характеристиками ділянку поверхні об'єкту. При 

необхідності координати кожного просторового об'єкта, відображеного 

набором пікселів, можуть бути обчислені. Точність в растрових форматах, в 

більшості випадків, визначається в половину ширини і висоти пікселя. 

Важливою характеристикою растрового зображення є роздільна здатність. 

Роздільна здатність - мінімальний лінійний розмір найменшої ділянки 

простору (поверхні), що відображається одним пікселем. Пікселі - 

прямокутники або квадрати, рідше використовуються шестикутники або 

трикутники. Більш високою роздільною здатністю володіє растр з меншим 

розміром пікселів. При цьому відображається велика кількість деталей. 

Найбільш часто растрові моделі застосовують при обробці аерокосмічних 

знімків для отримання даних дистанційних досліджень Землі. 

Стандартні формати растрових зображень: 

- TIFF- стандартний формат у топографічній графіці. Файли в форматі 

TIFF забезпечують кращу якість друку. 

- JPEG - призначений для зберігання зображень зі стисненням. 

- GIF - формат обміну графічними даними, який служить для запису і 

зберігання растрових графічних зображень. 

- WMF - використовується для обміну графічними даними між додатками 

ОС Microsoft Windows. 
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- PNG - формат зберігання растрової графіки, що використовує стиснення 

без втрати якості. 

Дії з растровими даними: 

 Склеювання, обрізання, накладування 

 Математичні операції попіксельно 

 Зміна роздільної здатності 

 Зміна системи координат 

 

Хід роботи 

Для завантаження даних скористаємось ресурсом GPCC Monitoring 

Product (Version 2020) – що містить дані про опади на всій планеті, які 

надаються державною установою Deutscher Wetterdienst (DWD) при 

Федеральному міністерстві цифрових технологій і транспорту Німеччини: 

https://opendata.dwd.de/climate_environment/GPCC/html/gpcc_monitoring_v202

0_doi_download.html 

Необхідно завантажити архів даних: 

 

Натисніть download і виберіть актуальний рік. Натиснувши на рік, 

відкриється таблиця з даними за кожен місяць року з різною роздільною 

здатністю. 

 

Завантажте дані кожного місяця поточного року із розміром пікселя 1о у 

папку Лаб4. Завантажені архіви розпакуйте до тієї ж папки. 
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Для роботи також потрібна папка ne_10m_admin_0_countries із 

попередньої роботи.  

Завантажимо у середовище 

Saga.gis дані з відповідних папок для 

кожного місяця. При цьому з’явиться 

діалогове вікно, в якому слід вибрати 

тільки один – р (32-bit floating point) і 

натиснути Okay. 
 

Також завантажимо шар ne_10m_admin_0_countries.shp 

Подвійним натисканням відкрийте шар першого місяця. У вікні перегляду 

зявиться карта опадів за січень. Після цього додайте шар 

ne_10m_admin_0_countries.shp.  Для полігонів кордонів країн встановіть 

стиль заповнення Display→Fill Style→Transparent, товщина ліній Size 2. 

Натисніть Apply. 

Для grid-файлу першого місяця у вікні властивостей відкрийте вкладку 

Descriptions і знайдіть інформацію про тип координатної системи, у якій 

створений даний растровий шар: Projection - Undefined Coordinate System. 

Це означає, що система координат не встановлена. Щоб її встановити, у 

головному меню програми відкрийте Geoprocessing→Projection→Set 

Coordinate Reference System. У вікні, що з’явилось, навпроти Geographic 

Coordinate System виберіть WGS84. У цьому ж вікні навпроти розділу Grids 

натисніть знак «…» - у результаті чого з’явиться ще одне діалогове вікно. У 

цьому вікні перемістіть з лівої частини у праву усі grid-файли, для яких не 

встановлена система координат. У даному випадку – усі, які завантажені у 

вікні управління. Натисніть Okay. Знов перевірте у вікні властивостей 

Descriptions Projection – тепер там  - Geographic Coordinate System [EPSG 

4326]:WGS84. 

Виріжемо фрагмент карти. Для цього запустимо відповідний модуль:  

Grid→Grid System→Clip Grids [interactive] 

У діалоговому вікні потрібно вибрати Grid-систему 
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Зверніть увагу: подвійна стрілка в таких діалогових вікнах означає 

обов’язковість заповнення даного поля. 

Натисніть на знак «…» навпроти Grids і перенесіть усі дані з лівої частини 

вікна у праву.  

У самому низу меню Geoprocessing 

можна побачити, що модуль Clip 

Grids – активовано. 
 

Для здійснення самої процедури, наблизьте фрагмент карти, який 

необхідно вирізати. На панелі інструментів натисніть на інструмент Action  

і виділіть ним необхідний регіон. Одразу після цього з’явиться вікно, у якому 

можна редагувати параметри обрізаного фрагменту. Без редагування 

натисніть Okay.  

У результаті, у верхній частині вікна управління з’явиться нова Grid-

система, що містить таку ж кількість растрових шарів, як і вихідний Grid.  

Багато модулів Saga.gis працюють з проекційними системами координат, а 

не з географічними. Тому, для подальшої роботи з обрізаними фрагментами 

карти потрібно перейти з географічної системи координат до проекційної. 

Для переходу з географічної системи координат до проекційної, слід 

визначити номер зони UTM (Universal Transverse Mercator), в якій 

знаходиться вибраний регіон. 

Для цього можна скористатись наступними ресурсами: 

 UTM Grid Zones of the World: https://www.dmap.co.uk/utmworld.htm 
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 What UTM Zone am I in ?: 

https://mangomap.com/robertyoung/maps/69585/what-utm-zone-am-i-in-

# 

Україна знаходиться у чотирьох зонах: 34, 35, 36, 37 N (північна півкуля). 

Запустимо модуль Geoprocessing→Projection→Coordinate 

Transformation (Grid List). У діалоговому вікні встановимо: 

 у розділі Projected Coordinate System виберемо зі списку необхідну 

зону UTM (для України – WGS84 zone UTM 35N) 

 у розділі Resampling виберемо β-Spline Interpolation (спосіб 

перерахунку значень растрів) 

 у розділі Grids ˃˃ Source виберемо обрізані дані (зверніть увагу на 

їх назву у вікні управління) і перенесемо їх з лівої частини вікна у 

праву.  

Після натисніть Okay.  

У вікні повідомлень з’являться повідомлення:  
Executing tool: Coordinate Transformation (Grid List) Tool execution succeeded 

 

А у вікні управління з’явиться нова Grid-система, яка містить обрізані 

фрагменти карти уже у спроектованій системі координат. Розмір 1-го пікселя 

у новій Grid-системі рівний 120000 метрів.  

Дві попередні Grid-системи можна видалити, натиснувши правою кнопкою 

Close. У вікні, що з’явиться, не потрібно позначати Save all. 

Щоб накласти кордони обраного регіону на обрізані растри, необхідно 

здійснити послідовність операцій: 

 Виділіть шейп файл ne_10m_admin_0_countries  у вікні управління. 

Потім на панелі інструментів виберіть інструмент Action і виділіть 

вибраний регіон на карті –у нашому випадку Україну. У результаті, 

кордони обраного регіону змінять забарвлення. 

 Створіть новий шейп файл, який містить тільки кордони України. 

Для цього запустіть модуль 
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Geoprocessing→Shape→Selection→Copy Selection to New Shapes Layer. 

У діалоговому вікні, що з’явилось, у розділі ˃˃Input виберіть 

ne_10m_admin_0_countries, а у розділі <<Output виберіть create. 

Натисніть Okay. У вікні управління з’явиться новий шейп файл 

ne_10m_admin_0_countries [Selection] 

 Шейп файл ne_10m_admin_0_countries закрийте. 

 Подвійним натисканням відкрийте шейп файл 

ne_10m_admin_0_countries [Selection] у вікні перегляду. 

 Для коректного накладання шейп файлу на растри, необхідно 

змінити його географічну систему координат на спроектовану. Для 

цього запустимо модуль Geoprocessing→Projection→Coordinate 

Transformation (Shape). У діалоговому вікні встановимо:  

o у розділі Projected Coordinate System виберемо зі списку 

необхідну зону UTM (для України – WGS84 zone UTM 35N) 

o у розділі Grids ˃˃Source виберемо 

ne_10m_admin_0_countries [Selection], а у розділі <<Target – 

create. Після натисніть Okay. 

o У вікні управління з’явиться новий шейп файл 

03.ne_10m_admin_0_countries [Selection] 

 Попередній шейп файл 02.ne_10m_admin_0_countries [Selection] 

закрийте. 

 Подвійним натисканням відкрийте 03.ne_10m_admin_0_countries 

[Selection] у вікні перегляду.  

Подвійним натисканням додайте один із растрів до карти кордонів. Якщо 

растр відкрився поверх карти кордонів, перейдіть у закладку Maps у вікні 

управління і перетягніть шейп файл вище растру. Поверніться у закладку 

Data.  

Із растрами можна виконувати математичні операції: додавання, 

віднімання, множення тощо. 
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Додамо растри за перші три місяці року (можна посезонно). Для цього 

запустимо модуль Geoprocessing→Grid→Calculus→Grid Calculator. Такий 

калькулятор виконує математичні дії з наявними растрами. У діалоговому 

вікні слід задати Grid-систему і вибрати перші три растри (січень 01, лютий 

02, березень 03). Також у розділі Formula введіть g1+g2+g3. Натисніть Okay. 

У вікні управління з’явиться новий растр Calculation. У вікні властивостей 

перейменуйте його на Calculation 1-3. 

Відкрийте даний растр у нову карту. Аналогічно просумуйте растри за 

наступні місяці і відкрийте карти Calculation 4-6, Calculation 7-9, 

Calculation 10-12. Також можна створити растр суми опадів за рік 

Calculation 1-12. 

Подвійним натисканням відкрийте шар Calculation 1-3 і додайте до нього 

векторний шар ne_10m_admin_0_countries [Selection]. Для векторного шару 

ne_10m_admin_0_countries [Selection] у вікні властивостей змініть стиль 

заповнення на прозорий: Fill Style→Transparent і збільшіть товщину лінії 

кордону до 2 Outline→Size. Застосуйте зміни, натиснувши Apply.  

Побудуємо Grid з максимальними (або мінімальними) значеннями растрів. 

Для цього запустимо модуль Geoprocessing→Grid→Grid 

System→Mosaicking. Інструмент Mosaicking накладає растри один на одний 

і вибирає задане користувачем значення: максимальне, мінімальне, середнє 

тощо. У діалоговому вікні у розділі ˃˃Input Grids виберіть досліджувані 

растри. У розділі Overlapping Areas виберіть необхідну функцію - 

maximum. Натисніть Okay. У вікні перегляду з’явиться новий растр Mosaic. 

Перейменуйте його на Maximum.  

Порівняємо значення кожного пікселя кожного гріду (місяця) з 

максимальними значеннями. Якщо значення першого місяця є 

максимальними, то значення відповідного пікселя зміниться на 1, якщо 

другого – на 2 і так далі. Для цього запустимо модуль грід-калькулятор: 

Geoprocessing→Grid Calculator. У діалоговому вікні у розділі Grids 

перемістимо наявні гріди (включаючи Maximum) з лівого вікна у праве.  
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У розділі <<Result залишаємо create. 

Наприклад, якщо грідів є 4 (за 4 місяці) + п’ятий грід Максимум, у розділі 

Formula запишемо: 

ifelse(g1=g5,1,ifelse(g2=g5,2,ifelse(g3=g5,3,4))) 

Запис ifelse(g1=g5,1,… означає: якщо значення пікселя у гріді-1 = 

значенню пікселя у гріді Максимум, то такому пікселю присвоюється 

значення «1». Якщо не дорівнює, перевіряються усі наступні гріди, допоки не 

буде знайдено такий, що має максимальне значення. У даному прикладі, 

якщо і третій грід не є максимальним, то автоматично, максимальне значення 

має четвертий грід.  

Після введення формули натисніть Enter. У вікні управління з’явиться 

новий грід  

У розділі Name введіть CompareToMax. Натисніть Okay.  

Відкрийте утворений грід у нову 

карту. Додайте до карти шейп-файл 

кордонів 

03.ne_10m_admin_0_countries 

[Selection]. У вікні властивостей 

позначте розділ Show Cell Values. На 

кожному пікселі фрагменту карти 

з’явиться код гріду (місяця), у якому 

на даній території була максимальна 

кількість опадів. 

 

Як видно з отриманої карти, максимальна кількість опадів майже по всій 

території України відбувається протягом 4-го місяця (з-поміж перших 

чотирьох місяців). 

Побудуємо ізолінії, тобто лінії, що з’єднують точки з однаковим 

значенням кількості опадів. Відкрийте грід Maximum і додайте до нього 

шейп-файл кордону України. Запустимо модуль 

Geoprocessing→Shapes→Grid→Vectorization→Contour Lines from Grid. У 
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діалоговому вікні виберіть відповідну грід-систему та грід Maximum. У 

розділі Contour встановіть create, у розділі Polygons встановіть not set. 

Також можна задати мінімальне (Minimum Contour Value) та максимальне 

(Maximum Contour Value) значення, які включатимуться у побудову 

ізоліній, і інтервал між значеннями (Equidistance).  

У вікні управління зявиться новий лінійний шейп-файл 

Maximum[Interval_]. Перегляньте таблицю його атрибутів. Відкрийте його, 

додавши до гріду Maximum. У вікні властивостей змініть забарвлення і 

товщину ізоліній. Підпишіть їх значення. Збережіть проект під назвою Lab4 у 

папці Лаб4.  

Збережіть одержане зображення 

Map→Save as Image…→Лаб4 з 

назвою IsolinesUkraine. Через 

провідник первірте вміст папки 

Лаб4, знайдіть і відкрийте файл 

Ukraine.png. 

 

 

Контрольні запитання: 

1. Поясніть відмінність між растровою та векторною моделями даних. 
Вкажіть переваги і недоліки. 

2. Охарактеризуйте суть поняття роздільна здатність растрового 
зображення.  

3. Назвіть стандартні формати растрових зображень 

4. Які дії здійснюють з растровими даними? 

5. Як встановити картографічну проекцію растру у середовищі Saga.gis? 

6. Як здійснити перехід з географічної системи координат до проекційної? 

7. Які функції виконує Grid Calculator у середовищі Saga.gis? 
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Лабораторна робота 5 

Робота з векторними даними 

 

ГІС може працювати з двома істотно відмінними типами даних - 

векторними і растровими. У векторній моделі інформація про точках, лініях і 

полігонах кодується і зберігається у вигляді набору координат X, Y. Місце 

розташування точки (точкового об'єкта), наприклад бурової свердловини, 

описується парою координат (X, Y). Лінійні об'єкти, такі як дороги, річки або 

трубопроводи, зберігаються як набори координат X, Y. Полігональні об'єкти, 

типу річкових водозборів, земельних ділянок або областей обслуговування, 

зберігаються у вигляді замкнутого набору координат. Векторна модель 

особливо зручна для опису дискретних об'єктів і менше підходить для опису 

безупинно мінливих властивостей, таких як типи грунтів або доступність 

об'єктів. Об’єкти векторної графіки можна вільно переміщувати чи 

змінювати без втрати деталей і чіткості, бо вони не залежить від роздільної 

здатності.  

З векторними даними можна виконувати наступні дії: 

 Редагувати геометрію 

 Операції з атрибутивними даними 

 Операції накладування 

 Логічні операції 

 Змінювати систему координат 

 

Хід роботи 

 

Для початку роботи перейдіть на сайт Natural Earth за посиланням  

http://www.naturalearthdata.com/ 

У розділі Downloads, Large scale data, Cultural завантажте дані про 

кордони країн Admin 0 – Countries, міста Populated Places та дороги Roads. 
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У розділі Downloads, Large scale data, Physical завантажте дані про ріки 

Rivers+lake centerlines Download rivers and lake centerlines  та озера Lakes+Reservoirs 

Download lakes . 

Для роботи з векторними даними потрібна растрова підкладка. Тому, у 

розділі Downloads, Large scale data, Raster, Natural Earth1 завантажте дані 

Natural Earth I with Shaded Relief and Water Download large size  

Створіть папку Лаб5, перемістіть та розархівуйте завантажені архіви у цю 

папку. 

Запустіть програму Saga.gis. Подвійним натисканням відкрийте растр 

NE1_HR_LC_SR_W.tif  у вікні перегляду. Після цього завантажте у 

середовище Saga.gis шейп-файли: 

 ne_10m_admin_0_countries.shp 

 ne_10m_populated_places.shp 

 ne_10m_roads.shp 

 ne_10m_rivers_lake_centerlines.shp 

 ne_10m_lakes.shp 

Додайте кордони країн до карти, у вікні властивостей зробіть їх 

прозорими (Fill Style→Transparent). 

Додайте шейп-файли річок та озер до карти, у вікні властивостей змініть 

їх забарвлення на Aqua. 

Додайте шейп-файл доріг до карти, у вікні властивостей змініть їх 

забарвлення на Gray. 

Також додайте шейп-файл міст до карти, у вікні властивостей змініть їх 

забарвлення на Blue. 

Робота з полігонами 

Збільшіть регіон карти, де знаходиться Україна. У вікні управління 

перейдіть до закладки Maps і подвійним натисканням на кожен шейп-файл 

приберіть з карти усі шари, крім кордонів країн.  

Виберіть для роботи кордони України, Польщі, Угорщини, Словаччини, 

Румунії та Молдови. Для цього у закладці Data виділіть шар 
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ne_10m_admin_0_countries, на панелі інструментів виберіть інструмент 

Action і розтягніть квадратом ареал, що охоплює території вищезгаданих 

країн. Кордони виділених країн змінили забарвлення на червоне. Відкрийте 

таблицю атрибутів шару ne_10m_admin_0_countries і переконайтесь, що 

виділені саме потрібні вам країни. Закрийте таблицю атрибутів. 

Виріжемо виділені полігони із загального шару ne_10m_admin_0_countries. 

Для цього запустимо модуль Geoprocessing→Shapes→ 

Selection→Copy Selection to New Shapes Layer. У діалоговому вікні у 

розділі ˃˃Input виберіть ne_10m_admin_0_countries, а у розділі <<Output 

виберіть create. Натисніть Okay. У вікні перегляду з’явиться новий шар 

ne_10m_admin_0_countries[Selection]. Відкрийте його у нову карту. 

Перейменуйте шар на EasternEurope.  

Також виріжемо виділені країни у новий грід. Для цього запустимо модуль 

Geoprocessing→Shapes→Grid→Spatial Extent→Clip Grid with Polygon. У 

діалоговому вікні у розділі Grid System виберіть грід систему, з якою 

відбувається робота, у розділі  ˃˃Input виберіть NE1_HR_LC_SR_W.tif, а у 

розділі ˃˃Polygons виберіть EasternEurope. У розділі Target Extent залиште 

polygon. Натисніть Okay.  

У вікні перегляду з’явиться новий грід. 

Перейменуйте його на EasternEurope. Грід 

складається з трьох частин. Відкрийте перший грід 

Band1 у нову карту. У вікні властивостей у розділі 

Colors→Type виберіть RGB Composite.  

 

 

Тут же, у вікні властивостей, 

відкриється розділ RGB Composite, у 

якому навпроти Grid system˃Green 

виберіть Band2, а навпроти Grid 

system˃Blue виберіть Band3. 

Натисніть Apply.  

Тепер обріжемо ріки, озера, міста та дороги відповідно до обрізаного гріду. 
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У вікні управління перейдіть до закладки Map і подвійним натисканням 

поверніть на карту шейп-файли рік, озер, міст та доріг. 

Для обрізання рік 

запустимо модуль 

Geoprocessing → 

Shapes → Lines → 

Line-Polygon 

Intersection.  

 

У діалоговому вікні заповнимо, як показано на 

рисунку. 

У результаті у вікні управління з’являться два лінійні шейп-файли: 

 

Шар Intersection містить ріки, що знаходяться всередині полігону 

EasternEurope, шар Difference містить усі інші ріки. Шар Difference можна 

закрити. У вікні властивостей перейменуйте шар Intersection на 

EasternEurope Rivers.  

Для обрізання 

доріг запустимо 

модуль 

Geoprocessing → 

Shapes → Lines → 

Line-Polygon 

Intersection.  

 

У діалоговому вікні заповнимо, як показано на 

рисунку. 

У результаті у вікні управління з’являться два лінійні шейп-файли: 

 

Шар Intersection містить дороги, що знаходяться всередині полігону 

EasternEurope, шар Difference містить усі інші дороги. Шар Difference 

закрийте. У вікні властивостей перейменуйте шар Intersection на 

EasternEurope Roads.  
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Для обрізання 

міст запустимо 

модуль 

Geoprocessing → 

Shapes → Points → 

Clip Points with 

Polygons.  

 

У діалоговому вікні заповнимо, як показано на 

рисунку. 

У результаті у вікні управління з’явиться один новий точковий шейп-файл: 

 

У вікні властивостей перейменуйте шар на EasternEurope Populated 

Places.  

Для обрізання 

векторного зображення 

озер запустимо 

модуль 

Geoprocessing→ 

Shapes→Polygons → 

Overlay→Intersect.  

 

У діалоговому вікні заповнимо, як показано на 

рисунку. 

У результаті у вікні управління з’явиться один новий точковий шейп-файл: 

 

У вікні властивостей перейменуйте шар на EasternEurope Lakes.  

Усі гріди та шейп-файли 

повного охоплення світу 

можна закрити.  

До обрізаного гріду додайте 

обрізані шейп-файли та 

змініть їх забарвлення, 

прозорість для зручності 

перегляду.  
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Редагування векторних даних 

Редагування лінійних об’єктів. 

Збільшіть фрагмент карти, наприклад 

поблизу міста Ужгород, так, щоб було 

чітко видно лінії доріг. У вікні 

управління виділіть шар доріг. На 

панелі інструментів натисніть на 

інструмент Action. Потім наведіть і 

натисніть на одну із ліній доріг для її 

виділення.  

 

Після цього правою кнопкою натисніть на виділений об’єкт, і у 

діалоговому вікні виберіть Edit Selection. Виділений лінійний об’єкт матиме 

вигляд набору точок, переміщуючи які можна редагувати його форму. 

Після завершення редагування знов натисніть правою кнопкою і виберіть 

Edit Selection і Apply Changes.  

Редагування точкових об’єктів. 

У вікні управління виділіть шар міст. На панелі інструментів натисніть на 

інструмент Action. Потім наведіть і натисніть на одну із точок для її 

виділення.  

Після цього правою кнопкою натисніть на виділений об’єкт, і у 

діалоговому вікні виберіть Edit Selection. Виділену точку можна 

перемістити. 

Після завершення редагування знов натисніть правою кнопкою і виберіть 

Edit Selection і Apply Changes. 

Редагування полігонів. 

У вікні управління виділіть шар озер. На панелі інструментів натисніть на 

інструмент Action. Потім наведіть на полігон озера і натисніть для його 

виділення. Після цього правою кнопкою натисніть на виділений об’єкт, і у 
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діалоговому вікні виберіть Edit Selection. Точки контуру полігона можна 

перемістити. Також можна додати точки на лінійному об’єкті Для цього 

(інструмент Action увімкнений) наведіть на лінію і лівою кнопкою натисніть 

1 раз. На лінії з’явиться додаткова точка. Для видалення точки виділіть її та 

натисніть Delete.  

Після завершення редагування знов натисніть правою кнопкою і виберіть 

Edit Selection і Apply Changes. 

Для векторних даних також можна змінювати систему координат і тип 

проекції. Для цього слід визначити номер зони UTM (Universal Transverse 

Mercator), в якій знаходиться вибраний регіон. 

Для цього можна скористатись наступними ресурсами: 

 UTM Grid Zones of the World: https://www.dmap.co.uk/utmworld.htm 

 What UTM Zone am I in ?: 

https://mangomap.com/robertyoung/maps/69585/what-utm-zone-am-i-in-# 

 

Україна знаходиться у чотирьох зонах: 34, 35, 36, 37 N (північна півкуля). 

Для виділення одного із полігонів, у вікні управління виділіть шейп-шар 

EasternEurope і виберіть інструмент Action на панелі інструментів. Наведіть і 

натисніть на обраний полігон. Для створення нового шейп-файлу, який 

міститиме тільки обраний полігон, запустіть модуль Copy Selection to New 

Shape Layer. Якщо ви нещодавно використовували цей модуль, виберіть 

його у нижній частині меню Geoprocessing. Або ж виберіть у меню - 

Geoprocessing→Shapes→Selection→ Copy Selection to New Shape Layer.  

У діалоговому вікні у розділі ˃˃Input оберіть шар EasternEurope, а у 

розділі <<Output оберіть create. Натисніть Okay.  

У вікні управління з’явиться новий полігональний шейп-шар. 

Перейменуйте його на Ukraine (або назву іншої країни, яку ви обрали). 

Відкрийте створений шар у нову карту. Тепер замінимо географічну систему 

координат даного шару на проекційну UTM 35N (для України).  
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Запустимо модуль Geoprocessing→Projection→Coordinate 

Transformation (Shapes). У діалоговому вікні встановимо: 

 у розділі Projected Coordinate System виберемо зі списку необхідну 

зону UTM (для України – WGS84 zone UTM 35N) 

 у розділі Shapes ˃˃Source виберемо шар Ukraine і <<Target – create.  

Після натисніть Okay.  

У вікні управління з’являється новий шейп-шар Ukraine. Перейменуйте 

його на UkraineUTM і відкрийте у нову карту. Порівняйте вигляд полігону 

Ukraine на двох картах, а також інформацію у вікні властивостей у розділі 

Description/Projection.  

Збережіть проект Lab5 і закрийте його. 

Створення нового шейп-файлу.  

Для створення шейп файлу запустіть модуль 

Geoprocessing→Shapes→Construction→Create New Shapes Layer.  

Створимо полігональний шейп-файл. У діалоговому вікні встановимо 

ім’я шару у розділі Name – Polygon, у розділі Shape Type – Polygon, Number 

of Attributes – 3. У розділі Attributes натисніть на «…» і у новому вікні 

встановіть наступні параметри: 

 

 

 

Після натисніть Okay. У вікні управління з’явиться створений шейп-файл. 

Відкрийте його. У вікні перегляду з’явиться пуста карта.  

На панелі інструментів виберіть інструмент Action і правою кнопкою миші 

натисніть по пустому полі. З’явиться діалогове вікно, у якому виберіть Add 

Shape. Послідовним натисканням відкладіть точки, які утворять контур 
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полігону. Після натискання останньої точки знов натисніть правою кнопкою 

миші і виберіть Edit selection і Apply changes.  

У вікні властивостей відкрийте закладку Attributes. У полі ID поставте 1 

(перший полігон), у полях Value 1 і Value 2 поставте довільні цілі чи дробові 

числа, що відображають певні атрибутивні (кількісні) показники полігону. 

Натисніть Apply. Після цього у вікні управління відкрийте таблицю 

атрибутів полігонального шару і перегляньте її вміст.  

Аналогічно створіть ще один полігон довільної форми і заповніть таблицю 

атрибутивних даних. Знов перегляньте атрибутивні дані у вікні управління.  

Редагувати атрибутивні дані можна відразу у відкритій таблиці. 

Створимо лінійний шейп-файл. Запустіть модуль 

Geoprocessing→Shapes→Construction→Create New Shapes Layer. У 

діалоговому вікні встановимо ім’я шару у розділі Name – Line, у розділі 

Shape Type – Lines, Number of Attributes – 3. У розділі Attributes натисніть 

на «…» і у новому вікні встановіть параметри аналогічно до тих, які 

встановлені для полігонального шару. 

У вікні управління з’явиться створений лінійний шейп-файл. Відкрийте 

його. У вікні перегляду з’явиться пуста карта.  

На панелі інструментів виберіть інструмент Action і правою кнопкою миші 

натисніть по пустому полі. З’явиться діалогове вікно, у якому виберіть Add 

Shape. Послідовним натисканням відкладіть точки, які утворять контур 

полілінію. Після натискання останньої точки знов натисніть правою кнопкою 

миші і виберіть Edit selection і Apply changes.  

У вікні властивостей у закладці Attributes заповніть поля атрибутів. 

Додайте ще одну ліній, змініть її атрибути. У вікні управління перегляньте 

таблицю атрибутів лінійного шейп-файлу. 

Аналогічно створіть точковий шейп-файл. Перевірте можливості 

створення точкового шару з використанням двох можливостей: Shape Type – 

Points і Multipoints. 
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Для вже доданих шейп-файлів можна редагувати атрибутивні дані і 

відповідні таблиці. Для цього використовують інструмент Field Calculator. 

Для його запуску можна використати два способи: 

1 2 

Geoprocessing→Shapes→Construction→Create New Shapes Layer 

 

Активуйте інструмент Field Calculator. У діалоговому вікні заповніть 

поля: ˃˃Shapes виберіть шар Polygon, Field – not set, Calculation – Value 3 

(новий атрибут), Result – create, Formula – f2+f3 (або інша необхідня 

математична дія), де f2 – атрибут, відображений у стовпчику Value 1, f3 – 

атрибут, відображений у стовпчику Value 2. Натисніть Okay.  

У вікні управління з’явиться новий шар з назвою Polygon. Перейменуйте 

його у Polygon1. Перегляньте таблицю його атрибутів. Відкрийте шар 

Polygon1 у нову карту. Порівняйте обидва шари. 

Векторні шари різного типу можна конвертувати один в одного. Для цього 

активуйте модуль Geoprocessing→Shapes→Conversion→Convert Polygons 

to Lines. У діалоговому вікні встановіть вихідний та результуючий шари. У 

вікні управління з’явиться новий лінійний шар. Відкрийте його у нову карту. 

Використовуючи інструмент Action, змініть положення точок. Аналогічно 

конвертуйте полігони у точки та лінії у точки. Закрийте проект, не 

зберігаючи його. 

 

Контрольні запитання: 
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1. Які дії можна здійснювати з векторними даними у середовищі Saga.gis? 

Які інструменти для цього використовують? 

2. Як змінити назву шейп-файлу? Як переглянути його атрибутивні дані? 

3. Який інструмент слід використати для вирізання частини растрового 

зображення і створення нового гріду? 

4. Який інструмент слід використати для вирізання частини векторного 

зображення? 

5. Які інструменти використовують для редагування векторних даних у 

середовищі Saga.gis? 

6. Охарактеризуйте систему координат універсальної поперечної проєкції 

Меркатора UTM. 
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Лабораторна робота 6 

Геоприв’язування та векторизація 

 

Найбільш складною частиною імпорту даних у ГІС є їх співвіднесення з 

місцем розташування об’єкта – цей процес називається геокодуванням або 

геоприв’язкою. Положення просторових об’єктів у середовищі ГІС може 

бути описане різними способами: 

– географічна прив’язка (територіальний принцип: материк, країна, місто). 

У цьому випадку геоприв’язкою виступає певна територія; 

– адресна прив’язка (країна, індекс, вулиця, дім, поверх, корпус, квартира 

або кадастровий номер об’єкта);  

– координатна прив’язка (градуси, мінути, секунди) іноді з позначенням 

висоти; 

– атрибутивна прив’язка (праворуч від вокзалу, напроти входу, біля школи, 

північніше західної околиці міста, збоку від кафе, у горах) тощо. 

Геоприв’язка - це процес надання координат реального світу кожному 

пікселю растра. 

Існує багато сервісів геокодування. Серед них - локальні, що діють на 

території певної країни, або ж і зовсім в межах конкретної місцевості чи 

окремо взятого будинку. Найбільш популярні сервіси геокодування, що 

діють по всьому світу: 

 OpenStreetMaps 

 Google Maps 

 Yandex Maps 
Зворотній процес – витяг описової інформації з об’єкта карти – 

називається зворотнім геокодування. Результатом такого процесу є 

текстова інформація в заздалегідь обумовленому форматі. 

Векторизація – це процес перетворення (оцифрування, трасування) 

об’єктів, відображених у растрі, у векторні полігони, лінії та точки.  
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Для роботи з растровим зображенням в середі ГІС необхідно відкрити 

файл як растрове зображення, виконати його прив'язку, після цього можна 

переходити до векторизації об'єктів.  

Існує три способи векторизації: ручний, інтерактивний і автоматичний. 

При ручній векторизації оператор обводить мишею кожен об'єкт. При 

інтерактивній - частка операцій проводиться автоматично. Так, наприклад, 

при векторизації горизонталей досить задати початкову точку і напрям 

відстежування ліній. 

Відскановані карти можна завантажити на сайтах 

 https://geoknigi.com/view_map.php?id=3 

 https://satmaps.info 

 http://freemap.com.ua/karty-ukrainy/karty-genshtaba 

 http://www.raster-maps.com/maps-of-ukraine/topographical-maps-of-

regions-of-ukraine/ 

 

 

Хід роботи 

 

Завантажте топографічну карту Ужгорода М-34-129. 

Для імпорту сканованої топографічної карти в середовище Saga запустіть 

модуль Georocessing→File→Grid→Import→Import Image (bmp, jpeg, png, 

tif, gif, pnm, xpm). У діалоговому вікні вкажіть шлях до файлу та натисніть 

Okay. У вікні управління з’явиться растр сканованої карти. Відкрийте його у 

нову карту. 

Геоприв’язування сканованої карти здійснюється за допомогою опорних 

точок. Чим більша кількість таких точок, тим точнішим буде прив’язування 

до географічної системи координат. Мінімальна кількість опорних точок – 5: 

у кутах карти та у її центрі.  

Запустіть модуль Projection→Georeferencing→Create reference points 

[interactive]. У діалоговому вікні натисніть Okay, не змінюючи параметри. У 
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вікні управління з’явиться точковий шейп-файл Reference points (Origin), 

який потрібно подвійним натисканням додати до карти. 

Для введення першої опорної точки збільшіть лівий верхній кут карти. 

Використовуючи інструмент Action подвійним клацанням мишки поставте 

точку на карті (у місці перетину ліній), а у діалоговому вікні Point Position 

введіть координати точки в десяткових градусах. Наприклад:  

 48о40’ – слід записати 
48.666666 
 50о15’ – слід записати 
50.2500 
 32о20’ – слід записати 
32.333333  

Для повернення до початкового вигляду карти використайте інструмент 

Zoom To Full Extent. Аналогічно розставте координат точок у трьох інших 

кутах карти а також у її центрі. Після цього зупиніть інтерактивний 

інструмент, вимкнувши ✔ навпроти Create reference points [interactive] у 

меню Geoprocessing.  

У вікні управління перегляньте таблицю атрибутів шару Reference points 

(Origin). 

На основі координат опорних точок переведемо скановану карту у 

географічну систему координат. Для цього слід запустити модуль 

Geoprocessing→Projection→Georeferencing→Rectify Grid. У діалоговому 

вікні встановіть параметри: 

 

Після натискання Okay з’явиться ще одне діалогове вікно, у якому лише у 

полі Cellsize встановіть значення 0,0001. Усі інші поля залиште без змін. 
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Натисніть Okay. У вікні управління з’явиться новий грід, назва якого 

починається з 0,0001. Відкрийте його у нову карту. Перейменуйте новий грід 

на M-34-129_geo. Цей растровий шар уже має географічні координати. 

У вікні властивостей у розділі Description Projection не встановлено 

проекційну систему Undefined Coordinate System. Для її встановлення 

запустимо модуль Geoprocessing→Projection→Set Coordinate Reference 

Sysytem. У діалоговому вікні встановіть: 

 у розділі Geographic 

Coordinate Systems 

виберіть зі списку WGS84 

 у розділі Projected 

Coordinate Systems 

виберіть зі списку 

необхідну зону UTM (для 

України – WGS84 zone 

UTM 35N) 
 

 у розділі Grids ˃˃ Source виберіть необхідний грід перенесіть його з 

лівої частини вікна у праву. 

Після натисніть Okay.  

Згідно методики лабораторної роботи №4, створіть точковий, лінійний та 

полігональний шари, додайте їх до карти і, використовуючи інструмент 

Action, векторизуйте по декілька об’єктів у кожному шарі. 

Збережіть проект під назвою Lab6 у папці Лаб 6.  

 

Контрольні запитання: 

1. Поясніть суть понять геокодування та зворотнє геокодування. 
2. Які способи векторизації растрів вам відомі? 
3. Які вимоги ставляться до процесу векторизації? 
4. Який інструмент використовують для геоприв’язки растрів у 

середовищі Saga.gis? 
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Лабораторна робота 7 

Супутникові знімки та класифікація поверхні 

 

Дистанційне зондування Землі (ДЗЗ) - це спосіб отримання інформації 

про земну поверхню та розташовані на ній об'єкти шляхом реєстрації 

електромагнітного випромінювання, що відбивається від них, без 

безпосереднього контакту.  

ДЗЗ із космосу характеризується такими перевагами: 

 високою оглядовістю, можливістю одержання одночасної інформації 

про великі території; 

 можливістю переходу від дискретної картини значень показників стану 

навколишнього середовища в окремих пунктах території до 

безперервної картини просторового розподілу показників; 

 можливістю одержання інформації про важкодоступні райони; 

 високим рівнем генералізації інформації. 

Методи дистанційного зондування 

Фотознімання - фотографування поверхні у всьому видимому диапазоні 

спектру чи певній його частині, а також в інфрачервоному диапазоні. 

Широко застосовується в повітряному та космічному зніманні з метою 

отримання даних для створення та оновлення карт. 

Сканерне знімання - знімання поверхні за допомогою оптичних або 

баготоспектральних пристроїв - сканерів. Відміною таких пристроїв від 

звичайних фотокамер є те, що сканер рухаючись вздовж або вздовж і поперек 

маршруту знімання поступово фіксує відбиття проміню від поверхні і 

направляє його в об'єктив. При зніманні поверхні за допомогою сканера 

формується зображення з окремих елементів (пікселів), кожному з яких 

відповідає яркість випромінювання ділянки поверхні. 
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Радарне знімання - активний метод знімання, що спирається на 

випромінювання в напрямку знімаємлї поверхні сигналу та прийом його 

вібиття. Зазвичай радарне знімання здійснюється в радіодиапазоні за 

допомогою локаторів богкового огляду (ЛБО). Перевагою цього методу є 

можливість виконання знімань в темний час доби та незначний вплив 

погодних умов: туману, хмарності. Радарне знімання використовується для 

визначення форми поверхні (рельєфу) та вивчення її геологічної структури. 

Теплове знімання - знімання в інфрачервоному диапазоні, що спирається 

на фіксацію теплового випромінювання поверхні та об'єктів, зумовленного 

сонячним випромінюванням або ендогенними процесами, та виявленні 

аномалій. Теплове знімання дозволяє виявляти елементи гідрографії, вивчати 

геологічну структуру поверхні, льодовий стан, вулканічну діяльність, 

температурну неоднорідність водного середовища, виявляти рельєф дна. 

Спектрометричне знімання - вимірювання відбиваючої здатності 

поверхні чи шарів речовини. Проводиться в мікрохвильовому, 

інфрачервоному диапазонах, а також у видимому та ближньому 

інфрачервоному диапазоні. Застосовується для вивчення гірських порід. 

Лідарне знімання - активне знімання поверхні шляхом неприривної 

фіксації відбиття від поверхні, яка опромінюється монохроматичним 

лазерним випроміннюванням з фіксованою довжиною хвилі. Здебільшого 

лідарне знімання ведеться з носіїв з недуже великою висотою польоту. 

Частота випромінювання налаштовується на резонансні частоти поглинання 

скануємого компоненту і таким чином у випадку наявності значних 

концентрацій цього компоненту відбиття значно збільшується. 

Застосовується для вивчення нижніх шарів атмосфери, виявлення 

концентрації певних елементів та з'єднань. 

[Джерело:GeoGuide: http://www.geoguide.com.ua/survey/survey.php?part=dzz] 
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Класифікація поверхні Землі – присвоєння певного типу (ліс, водойма, 

гори, пустеля тощо) обмеженій ділянці поверхні Землі. 

Космічний знімок Класи поверхні 

 

Звичайне фото Дані для роботи в ГІС 

 

Хід роботи 

 

Для завантаження космічних знімків перейдіть за посиланням: 

EarthExplorer: https://earthexplorer.usgs.gov 

Для використання сайту і завантаження даних необхідно зареєструватись! 

Після реєстрації знайдіть на карті необхідний регіон, відкрийте закладку 

Search Criteria і послідовним натисканням (4 рази) навколо вибраного 

регіону виділіть його. 

 

Перетягуючи сині прапорці, ви можете змінювати площу вибраного 

регіону. 

Перейдіть до закладки Data Sets і виберіть розділ Landsat.  
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Landsat — найтриваліший проект з 

отримання супутникових фотознімків 

планети Земля. Перший з супутників в 

рамках цієї космічної програми був 

запущений в 1972 році; останній, на цей 

момент, Landsat 8 — 11 лютого 2013 

року. Обладнання, що було встановлене 

на супутниках Landsat, зробило мільярди 

знімків. Знімки, отримані в США і на 

станціях отримання даних зі супутників по всьому світу, є унікальним ресурсом для 

проведення безлічі наукових досліджень у галузі сільського господарства, картографії, 

геології, екології, лісівництва, розвідки, освіти і національної безпеки. [Вікіпедія: 

https://uk.wikipedia.org/wiki/Landsat] 

У розділі Landsat виберіть Landsat 

Legacy→ETM+(1999-2003) і натисніть 

Results. 

Для завантаження виберіть один із 

запропонованих архівів і натисніть значок для 

завантаження, як показано на рисунку нижче. 

  

Завантажений архів скопіюйте до папки Лаб 7 і розпакуйте його. 

Перегляньте вміст папки. Зображення tif, що містяться у папці, уже мають 

географічну прив’язку. 

Запустіть програму Saga.gis і відкрийте файли з архіву 

(File→Open→Лаб 7). У вікні управління з’являться декілька грід-систем з 

різною роздільною здатністю (14×14м, 28×28м, 57×57м…). Різні космічні 

знімки, що входять до даних грід-систем, зроблені в різних спектральних 
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діапазонах. У вікні властивостей перегляньте інформацію про них, зокрема 

про їх проекційну систему координат (наприклад WGS84/UTMzone36N).  

Щоб отримати «звичне для людського ока» зображення, необхідно 

об’єднати (змішати) растри різних діапазонів.  

Для правильного змішування каналів, скористайтесь ресурсом  

https://web.pdx.edu/~nauna/resources/10_BandCombinations.htm 

Для одержання «звичного для 

людського ока» зображення (the 

"natural color" band combination) 

канал 3 (band3) має відповідати 

червоному кольору, канал 2 – 

зеленому, канал 1 – синьому. Для 

цього у вікні управління виділіть 

растр, що відповідає каналу 3, а у вікні 

його властивостей у розділі Settings 

виберіть Colors Type RGB Composite 

і встановіть, як показано на рисунку: 

 

Для відображення рослинного покриву використовують змішування 

каналів 4-Червоний, 3-Зелений, 2-Синій. При такому змішуванні рослинний 

покрив відображатиметься червоним кольором.  

У вікні управління 

виділіть растр, що 

відповідає каналу 4, а у 

вікні його властивостей у 

розділі Settings виберіть 

Colors Type RGB 

Composite і встановіть, як 

показано на рисунку: 
 

Комбінація каналів 7-Червоний, 4-Зелений, 2-Синій використовується 

для геологічних, сільськогосподарських і водно-болотних досліджень. 
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Здорова рослинність буде яскраво-зеленою, луки будуть виглядати зеленими, 

рожеві ділянки представляють безплідний ґрунт, помаранчеві та коричневі - 

представляють рідкорослі ділянки. Суха рослинність буде помаранчевою, а 

вода блакитною. Пожежі відображаються червоним кольором. Ця комбінація 

використовується в додатках управління пожежами для аналізу згорілих і не 

згорілих лісових масивів після пожежі.  

Класифікація поверхні 

Космічний знімок ареалу, який потрібно класифікувати, може містити 

території різного типу. Тому, першим кроком є присвоєння кожному типу 

певного цифрового коду. Наприклад, 

1 – вода, 2 – хмари, 3 – тінь від хмар, 4 – поля, вкриті травою, 5 – грунт без 

рослинності, 6 – поля сільськогосподарського призначення, 7 – ліси, 8 – 

урбанізовані території (міста). 

Чим більшу кількість таких типів виділить користувач, тим більш точною 

буде класифікація. При недостатній кількості – частина територій буде 

класифікована невірно.  

На растрі типу "natural color" слід вказати ці типи територій. Для цього 

створіть полігональний шейп-файл Geoprocessing→Shapes→Construction→ 

Create New Shape Layer. У полі Name змініть назву на Classes, у полі Shape 

Type виберіть Polygon, усе інше залиште без змін. У вікні управління 

з’явиться полігональний шейп-файл Classes без встановленої координатної 

чи проекційної прив’язки.  

Тому, встановимо проекційну систему координат для даного шейп-файлу. 

Для цього використаємо інструмент Geoprocessing→Projection→Set 

Coordinate Reference System. У вікні, що з’явилось, у розділі Shapes 

натисніть знак «…» - у результаті чого з’явиться ще одне діалогове вікно. У 

цьому вікні перемістіть з лівої частини у праву шейп-файл Classes, для якого 

не встановлена система координат. Натисніть Okay. Встановимо для шейп-

файлу Classes таку проекційну систему, яка уже є для завантажених растрів. 

Для цього у розділі Loaded Grid навпроти Grid System виберіть необхідну 
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грід-систему, а навпроти Grid – будь який растр, який належить до обраної 

грід-системи. Натисніть Okay. Знов перевірте у вікні властивостей 

Descriptions Projection – тепер там  - Prijected Coordinate System [EPSG 

32636]:WGS84/UTMzone36N. 

Додайте шейп-файл Classes на растр типу "natural color" (band 3). 

Перевірте таблицю атрибутів шейп-файлу. Вона – поки пуста.  

Створимо перший тип полігонів – вода (1). У вікні управління натисніть на 

шар Classes а на панелі інструментів  виберіть інструмент Action. Натисніть 

правою кнопкою по карті і виберіть Add Shape. При нанесенні точок контуру 

полігону намагайтесь максимально точно відтворити його. Від точності 

включення необхідних пікселів до певного типу полігонів залежить точність 

подальшої обробки програмою всього растру. Для збільшення точності 

відтворення контуру полігону, збільшіть векторизовану ділянку растру і, 

використовуючи інструмент Action, переміщуйте точки, додавайте нові 

точки так, щоб максимально повторити контури полігону. Щоб отримати 

репрезентативну вибірку, необхідно векторизувати максимальну кількість 

водних об’єктів. Після завершення знов натисніть правою кнопкою і зніміть 

виділення з опціїї Edit Selection. Натисніть Apply changes. Виділений 

полігон змінить забарвлення. 

   

Відкрийте таблицю атрибутів шейп-файлу Classes. 

У стовпчиках ID та Name поставте 1 та «water» 

відповідно, що означає належність полігонів до 

класу Вода. 
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Наступний клас для векторизації – хмари (клас 2). Послідовність дій – та 

ж, що і для води. Таким чином створіть полігони для усіх класів, які 

представлені на карті. 

Після цього запустіть інструмент для класифікації просторових об’єктів: 

Geoprocessing→Imagery→Classification→Supervised Classification for 

Grids. У вікні, що з’явилось, встановіть: 

Grid System: ту грід систему, до якої належить растрова підкладка, на якій 

проводилась векторизація. 

Features: додайте усі растри, що входять до даної грід-системи. 

Сlassification: create. 

Quality: create (оцінка якості класифікації у кожному пікселі) 

Training Areas: виберіть шейп-файл Classes 

Class Identifier: ID 

Save Statistic to File: - 

Method: Minimum Distance 

 

Натисніть Okay. Процес класифікації програмою може зайняти тривалий 

час (30-60 хв). Після завершення роботи інструменту, у вікні управління 

з’явиться новий растр Classification. У вікні властивостей у розділі Colors 

Type виберіть Lookup Table і змініть забарвлення класифікованих полігонів 

на більш природне. 
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Для векторизації отриманого растру Classification використайте інструмент 

Geoprocessing→Shapes→Grid→Vectorization→Vectorising Grid Classes. У 

вікні, що з’явилось, встановіть: 

Grid System: ту грід систему, до якої належить растрова підкладка, на якій 

проводилась векторизація. 

Grid: Сlassification. 

Polygons: create. 

Class Selection: all classes 

Vectorised Class as: one single polygon object  

Натисніть Okay. У вікні управління з’явиться новий шейп-файл 

Сlassification. Відкрийте його у нову карту. Збережіть проект Lab7 до папки 

Лаб 7. 

 

Контрольні запитання: 

1. Розкрийте суть технології ДЗЗ. Які переваги має ДЗЗ? 

2. Охарактеризуйте суть основних методів ДЗЗ. 

3. Поясніть суть процесу класифікації поверхні Землі. 

4. Охарактеризуйте проект з отримання супутникових фотознімків 

Landsat.  

5. Які комбінації спектральних каналів проекту Landsat використовують 

для відображення об’єктів реального світу у сільському господарстві та 

природоохоронній діяльності? 
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Лабораторна робота 8 

Імпорт GPS-точок у Saga.gis. Робота з таблицями 

 

GPS, Систе́ма глоба́льного позиціювання (англ. Global Positioning 

System) — сукупність радіоелектронних засобів, що дозволяє визначати 

положення та швидкість руху об'єкта на поверхні Землі або в атмосфері. 

Положення об'єкта обчислюється завдяки використанню розміщеного на 

ньому GPS-приймача, який приймає та обробляє сигнали супутників 

космічного сегменту GPS-системи глобального позиціонування. Для 

визначення точних параметрів орбіт супутників та керування GPS-системою 

вона в своєму складі має наземні центри управління. Створена і 

використовується Міністерством оборони США. Працює з низькою точністю 

у приполярних регіонах. 

Система NAVSTAR має 24 робочих супутники з орбітальним періодом по 

12 годин на висоті приблизно 20200 км від поверхні Землі. У шести різних 

площинах, що мають нахил до екватору у 55°, розташовано по 4 супутники. 

Зазначена висота необхідна для забезпечення стабільності орбітального руху 

супутників і зменшення фактору впливу опору атмосфери. 

Міністерство Оборони США (DoD) здійснює безперервне спостереження 

за супутниками. На кожному супутнику розташовано декілька високоточних 

атомних годинників і вони безперебійно передають радіосигнали з власним 

унікальним ідентифікаційним кодом. МО США має 4 станції стеження за 

супутниками, три станції зв'язку та центр, що здійснює контроль і управління 

за усім наземним сегментом системи. Станції спостереження безперервно 

відстежують супутники і передають дані у центр управління. У центрі 

управління обчислюються уточнені елементи супутникових орбіт і 

коефіцієнти поправок супутникових шкал часу, після чого ці дані 

передаються по каналам станцій зв'язку на супутники принаймні один раз на 

добу. 
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Хід роботи 

 

У середовище Saga.gis неможливо 

завантажити GPS координати точок з 

використанням файлу .xls (Excel). Але 

можна конвертувати .xls файл у формат 

.*txt (.dbf). Для цього створіть .xls файл з 

GPS координатами точок, наприклад 

європейських столиць.  

Зверніть увагу, значення довготи і 

широти вводяться у десятковому форматі. 

Пам’ятайте: Х – довгота, Y- широта!  

 

Збережіть .xls файл у форматі  

 у робочу 

папку Лаб 8.  

Запустіть програму Saga.gis. Натисніть 

File > Table > Load 

У вікні управління з’явиться таблиця з 

відповідною назвою.  

 

Перегляньте вміст таблиці і переконайтесь, що всі координати додані. 
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Для конвертування таблиці у точковий шейп-файл, використайте 

інструмент, для запуску  якого у вікні управління натисніть закладку 

Tools→Shapes→Points→Convert Table to Points  (або 

Geoprocessing→Shapes→Conversion→Convert Table to Points) 

 

 

У діалоговому вікні, що з’явилось, заповніть, 

як показано на зображенні: 

 

Натисніть Okay.  

У вікні управління з’явиться точковий шейп-файл з такою ж назвою. 

Відкрийте його у нову карту. У вікні властивостей у розділі Labels Attribute 

виберіть Name. Точки на карті отримають підписи назв міст. У вікні 

властивостей у розділі Description вказано, що тип проекції даного шейп-

файлу не встановлено: Projection - Undefined Coordinate System.  

Для встановлення проекційної системи координат використаємо 

інструмент Geoprocessing→Projection→Set Coordinate Reference System. У 

вікні, що з’явилось, у розділі Shapes натисніть знак «…» - у результаті чого 

з’явиться ще одне діалогове вікно. У цьому вікні перемістіть з лівої частини у 

праву шейп-файл GPS points, для якого не встановлена система координат. 

Натисніть Okay. Навпроти Geographic Coordinate System виберіть WGS84. 

Натисніть Okay. Знов перевірте у вікні властивостей Descriptions Projection 

– тепер там - Prijected Coordinate System [EPSG 

32636]:WGS84/UTMzone36N. 

Збережіть проект з назвою Lab8.1 до папки Лаб 8. Закрийте проект. 

Розглянемо інший спосіб імпорту GPS-даних у середовище Saga.gis – за 

допомогою програми Google Earth.  
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Запустіть програму Google Earth, виберіть і наблизьте територію чи 

населений пункт, з картою якого ви працювали у Лабораторній роботі №6 

(місто Ужгород). У головному меню виберіть Add (Додати)→Folder (Папка). 

У лівій частині у меню з’явиться папка. Натисніть на неї правою кнопкою і 

перейменуйте у Лаб8. У цю папку буде додано точки і маршрути, які ви 

позначите на карті. На панелі інструментів виберіть Додати мітку 

.  

У вікні перегляду з’явиться жовтий знак для позначення точок на карті, а 

також діалогове вікно: 

 

Перетягніть жовту мітку у необхідне місце на карті, після чого натисніть 

Ок у діалоговому вікні. Позначте на карті 5-10 точок. Змініть назву кожної 

точки на номер (права кнопка-Перейменувати).  

Також додайте маршрути до папки. Активуйте інструмент Додати 

маршрут на панелі інструментів .  

Послідовним натисканням на вибрані локації 

на карті додаватимуться точки, які 

сполучаються у ламану лінію - маршрут. У 

діалоговому вікні, що при цьому відкриється, 

змініть назву маршруту (номер або назва).  

Перегляньте вміст створеної папки, перевірте  
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кількість створених точок і маршрутів. 

Правою кнопкою миші натисніть на папку Лаб8 і виберіть Зберегти 

розташування як… Папка з точками і маршрутами збережеться з 

розширенням Лаб8.kmz У діалоговому вікні вкажіть шлях до папки Лаб8. 

Для завантаження у середовище Saga.gis, необхідно конвертувати дані 

.kmz у формат .gpx. Для цього скористайтесь онлайн-ресурсом ASPOSE: 

https://products.aspose.app/gis/uk/conversion 

На сторінці сайту натисніть Завантажте свій файл і вкажіть шлях до нього. 

Після цього натисніть Зберегти як, виберіть формат GPX і підтвердіть 

конвертацію. Конвертований файл збережіть у папку Лаб8.  

  

У програмі Saga.gis виберіть Geoprocessing→File→Shapes→Import 

→Import GPX.  У діалоговому вікні вкажіть шлях до файлу.  У вікні 

управління з’явиться набір точкових шейп-файлів, що відповідають 

створеним у Google Earth точкам та маршрутам. Перегляньте їх таблиці 

атрибутів та відкрийте у нову карту. Використовуючи інструмент 

Geoprocessing→Projection→Set Coordinate Reference System, встановіть 

для шейп-файлів систему координат WGS84.  

Завантажте у середовище Saga.gis прив’язаний до географічної системи 

координат растр .geo.sgrd 

Накладіть шейп-файли Лаб8 на карту .geo.sgrd 

Порівняйте розташування відкладених точок на картах у Saga.gis та 

Google Earth. 
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Збережіть проект з назвою Lab8.2 до папки Лаб 8. Закрийте проект. 

Додавання даних до GPS-точок 

Відкрийте файл з географічними координатами європейських столиць, 

який ви використовували для створення проекту Lab8.1. 

Додамо у таблицю дані про рівень запиленості повітря вказаних міст. Для 

цього використаємо онлайн-ресурс European city air quality viewer: 

https://www.eea.europa.eu/themes/air/urban-air-quality/european-city-air-

quality-viewer 

У файлі .xls навпроти кожного міста додайте числові дані про Fine 

particulate matter PM2.5: - показник, що характеризує вміст у повітрі дрібних 

частинок пилу розміром менше 2.5 мкм (одиниці вимірювання - мкг/м3). Такі 

частинки пилу мають найбільш негативний вплив на здоров’я населення.  

Збережіть .xls файл під назвою Fine particulate matter у форматі    

 у робочу папку Лаб 8.  
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Відкрийте таблицю у Saga.gis. (File > Table > Load) 

У вікні управління з’явиться таблиця з відповідною назвою. Для 

конвертування таблиці у точковий шейп-файл, використайте інструмент, для 

запуску  якого у вікні управління натисніть закладку 

Tools→Shapes→Points→Convert Table to Points  (або 

Geoprocessing→Shapes→Conversion→Convert Table to Points) 

Перегляньте таблицю атрибутів створеного шейп-файлу. Встановіть 

систему координат для шейп-файлу WGS84.  

Для зручності перегляду здійснимо градацію забарвленням у залежності 

від значення Fine particulate matter. У вікні властивостей у розділі Colors 

Type виберіть Graduated Colors. У розділі ScalingColors натисніть на «…» 

біля «11colors». У діалоговому вікні, що з’явилось, натисніть Presets та 

виберіть комбінацію yellow-red. Натисніть Okay.  

У розділі Attribute виберіть стовпчик, за значеннями якого відбудеться 

градація кольором. У даному випадку – це Fine particulate matter PM2.5. 

Натисніть Apply. Точки, в яких значення Fine particulate matter є 

невисоким, відображатимуться жовтим кольором, точки з високими 

значеннями атрибуту – будуть забарвлені у червоний колір. 

Для зручності перегляду завантажимо растрову підкладку для точкового 

файлу з європейськими столицями. У меню SAGA.gis виберіть 

File→Open→Лаб1→HYP_50M_SR_W→ HYP_50M_SR_W.tif Подвійним 

натисканням на назву карти  у вікні управління відкрийте карту у вікні 

перегляду. Додайте шейп-файл Fine particulate matter на карту 

HYP_50M_SR_W.tif У вікні властивостей підпишіть назви столиць. 

Тепер додамо додаткові дані до точок із растру, на який вони накладені. 

Завантажити растрові дані (висотну модель) можна на сайті SRTM Tile 

Grabber http://dwtkns.com/srtm/   (див. Лабораторна робота 1) 

Для цього необхідно виділити квадрат необхідного вам регіону і натиснути 

Download GeoTIFF (зображення з географічною прив’язкою). Завантажте і 

розпакуйте файли квадрату 40. 
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Завантажте файл srtm_40_03.tif у середовище 

Saga.gis. Відкрийте його у нову карту. Додайте 

шейп-файл Fine particulate matter на карту 

srtm_40_03.tif 

Скільки точок потрапили на растр? Які це 

міста? 

Тепер, користуючись завантаженими висотними даними із растру 

srtm_40_03.tif, визначимо висоту над рівнем моря міст, що відповідають цим 

точкам. Запустіть інструмент: Geoprocessing→Shapes→Grid→Grid 

Values→Add Grid Values to Points. У діалоговому вікні, що з’явиться, 

заповніть, як показано нижче: 

 

У вікні управління з’явиться новий шейп-файл 02.fine particulate matter.  

Перегляньте його таблицю атрибутів і визначте відмінність з таблицею 

атрибутів шейп-файлу 01.fine particulate matter. 

Повторіть ту саму процедуру, використавши інструмент 

Geoprocessing→Shapes→Grid→Grid Values→Add Grid Values to Points. 

Але в якості джерела висотних даних використайте растр 

HYP_50M_SR_W.tif. Збережіть проект з назвою Lab8.3 до папки Лаб 8. 

Закрийте проект. 

 

Контрольні запитання: 

1. Принцип дії та структура глобальної навігаційної супутникової системи 
GPS. 

2. Які способи імпорту GPS даних у середовище ГІС-програм вам відомі? 
3. Як створити точкові та лінійні об’єкти у програмі Google Earth для 

подальшого імпорту їх у середовище Saga.gis? 
4. Як додати дані у атрибутивну таблицю шейп-файлу? 
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Лабораторна робота 9 

Інтерполяція даних. Метод крігінгу 

 

Інтерполяція - встановлення значення функції на заданому інтервалі за 

відомими її значеннями точок, що належать цьому інтервалу. 

Методи інтерполяції: лінійна інтерполяція; метод зворотних зважених 

відстаней, кригінг; сплайн-інтерполяція; тренд-інтерполяція.  

Крігінг. Метод інтерполяції, який заснований на використанні методів 

математичної статистики. У його реалізації застосовується ідея 

регіоналізованої змінної, тобто змінної, яка змінюється від місця до місця з 

деякою видимої безперервністю, тому не може моделюватися тільки одним 

математичним рівнянням. Поверхня розглядається у вигляді трьох 

незалежних величин. Перша - тренд, характеризує зміну поверхні в певному 

напрямку. Далі передбачається, що є невеликі відхилення від загальної 

тенденції, на зразок маленьких піків і западин, які є випадковими, але все ж 

пов'язаними один з одним просторово. 

Щоб зробити прогноз за допомогою методу інтерполяції Крігінг, 

необхідно вирішити два завдання:  

 Створити варіограму.  

 Зробити прогноз.  

Емпірична варіограма 

 

По осі Y відкладається 

варіативність (половина різниці 

значень двох точок), а по осі X – 

відстань між точками. 

V(AB)=0.5×│A-B│ 
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Хід роботи 

Завантажимо дані з проекту Lab8.3 (Лабораторна робота 8).  

Запустимо інструмент Geoprocessing→Spatial and 

Geostatistics→Kriging→Ordinary Kriging. У діалоговому вікні, що 

з’явиться, заповніть, як показано нижче: 

 

Усе інше залиште без змін. Натисніть Okay. З’явиться нове діалогове 

вікно, що відображає параметри варіограми – Variogram.  

 

 

 

Очікувано варіограма показує збільшення варіативності із збільшенням 

відстані між точками. У вікні Variogram дано значення коефіцієнтів a і b у 

рівнянні y=a+bx, а також значення достовірності одержаної залежності – 

Determination. У вікні варіограми можна змінювати залежність, за якою 

здійснюватиметься обробка результатів. Для цього у розділі Predefined 
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Functions можна вибрати будь-яку іншу функцію: квадратичну, кубічну, 

логарифмічну… Натисніть Ok. 

У вікні управління з’явиться новий растр [Ordinary Kriging] – результат 

інтерполяції за заданими параметрами. Відкрийте його у нову карту. Змініть 

кольорову гамму нового растру на таку, як ви використовували у проекті 

Lab8.3. У вікні властивостей у розділі Colors Type виберіть Graduated 

Colors. У розділі ScalingColors натисніть на «…» біля «11colors». У 

діалоговому вікні, що з’явилось, натисніть Presets та виберіть комбінацію 

yellow-red. Натисніть Okay.  

Накладіть на утворений растр точковий шейп-файл 02.fine particulate 

matter. Перевірте, чи растрова підкладка і накладений на неї шейп-файл 

мають однакові налаштування кольорової гамми.  

Накладіть растр [Ordinary Kriging] на растр початкової карти - 

HYP_50M_SR_W.tif.  У вікні управління у розділі Maps перетягніть шейп-

файл вище обох растрів. Також у вікні властивостей для растру [Ordinary 

Kriging] встановіть прозорість 10%.  

Збережіть зображення до папки Лаб 9. Також збережіть проект Lab9 до 

папки Лаб 9. 

 

Одинарний крігінг дає достовірні результати для даних, які змінюються 

неперервно – наприклад, запиленість повітря, вміст шкідливих речовин у 

повітрі тощо. Для даних, що змінюються дискретно, різко – такий метод дає 

значну похибку. 
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Для інтерполяції неоднорідно вкритої рослинністю поверхні 

використовують метод NDVI – Normalized Difference Vegetation Index – 

кількісний показник фотосинтетично-активної біомаси (вегетаційний індекс). 

Показник NDVI набуває значень від -1 до +1. Від -1 до 0: поверхня не має 

рослинності – це скелі, каміння, дороги, будинки, пустеля, сніг, вода. Від 0 до 

+1: поверхня вкрита рослинністю.  

Він розраховується за супутниковими знімками і залежить від того, як 

рослини відбивають та поглинають світлові хвилі різної довжини. 

Наприклад, рослини для нашого ока зелені тому, що пігмент хлорофіл добре 

відбиває зелені хвилі. Також хлорофіл поглинає червоні хвилі: за рахунок 

цього відбувається фотосинтез, тобто культура зростає та розвивається. А 

клітинна структура рослини відбиває ближні інфрачервоні хвилі. Отже, 

здорова рослина, в якій багато хлорофілу та хороша клітинна структура, 

активно поглинає червоне світло та відображає ближнє інфрачервоне. Хвора 

рослина – навпаки. 

Щоб зрозуміти стан здоров'я рослини, треба 

обчислити відношення між різницею інтенсивностей 

відбитого світла в червоному (Red) та 

інфрачервоному діапазоні (Nir) та їх сумою. 

REDNIR

REDNIR
NDVI




   

Розрахунок NDVI відбувається на основі супутникових знімків 
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Із папки Лаб 7 завантажте три грід-файли, що відповідають каналам 

Band2, Band3 та Band4.  

 

Використайте грід-калькулятор для 

розрахунку NDVI. Для цього використайте 

інструмент: 

Geoprocessing→Grid→Calculus→Grid 

Calculator 

У діалоговому вікні перенесіть гріди 30 

(Band3) та 40 (Band4) і задайте формулу: 

(g2-g1)/(g1+g2), де g2-Band4, g1-Band3 

 

Натисніть Okay. У вікні управління з’явиться новий растр NDVI. 

Відкрийте його у нову карту. Змініть кольорову гамму растру: у вікні 

властивостей встановіть Colors Type RGB Composite, у якому навпроти Grid 

system˃Green виберіть Band3, а навпроти Grid system˃Blue виберіть Band2. 

Натисніть Apply.  

Виберіть і збільшіть фрагмент растру. Проведіть курсором і визначте, які 

значення має NDVI індекс (нижня частина вікна перегляду) на ділянках 

різного забарвлення.  

Ще один спосіб розрахунку NDVI індексу: запустіть інструмент 

Geoprocessing→Imagery→Vegetation Indices→ Vegetation Index (Slope 

Based). 

У діалоговому вікні виберіть, як вказано нижче: 
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У вікні управління з’явиться новий растр з назвою Normalized Difference 

Vegetation Index. Відкрийте його у нову карту.  

Для порівняння двох растрів, одержаних за допомогою різних 

інструментів, натисніть правою кнопкою на грід NDVI і виберіть Scatterplot 

(діаграма розсіювання). У діалоговому вікні встановіть, як вказано нижче: 

 

Нове діалогове вікно покаже ступінь кореляції значень пікселів обох 

растрів. 

Збережіть проект Lab9.1 до папки Лаб 9. 

 

Контрольні запитання: 

1. Які види інтерполяції використовують у ГІС? 

2. Метод гравітації, метод оберненого середнього зважування. 

3. Поясніть суть методу крігінгу. Які види крігінгу вам відомі? 

4. Як будують варіограму?  

5. Як визначають NDVI-індекс? Де його використовують? 
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Перелік питань для підготовки до іспиту  
з навчальної дисципліни «ГІС в екології» 

 
1. Поняття геоінформатики та геоінформаційних систем.  
2. Основні розділи геоінформатики. Зв'язок геоінформатики з іншими 

науками. 
3. Інформатизація суспільства. Основні процеси інформатизації. 
4. Історія ГІС. Основні етапи. 
5. Складові частини ГІС. Сфери застосування ГІС.  
6. Класифікація ГІС. 
7. Введення даних у ГІС. Джерела даних для ГІС. 
8. Бази даних (БД). Основні типи баз даних. 
9. Ієрархічна модель БД. 
10. Мережева модель БД. 
11. Реляційна модель БД. 
12. Системи керування базами даних (СКБД). Основні функції СКБД. 
13. Типи даних в ГІС. 
14. Зв'язок між просторовими та атрибутивними даними. Геокодування. 
15. Бібліотеки умовних знаків. Метадані. 
16. Базові елементи просторових об’єктів. 
17. Моделі просторових даних. Основні типи. 
18. Загальна характеристика растрових моделей даних. 
19. Загальна характеристика векторних моделей даних. 
20. Порівняння растрової і векторної моделей даних. 
21. Основи роботи у середовищі Saga.gis 
22. Векторизація растрового зображення (приклад). Способи векторизації. 
23. Типи векторних моделей даних.  
24. Топологічні властивості об’єктів. Елементи топологічної векторної 

моделі. 
25. Деякі правила топології, реалізовані  в Saga.gis та ArcGis. 
26. Модель GRID. Способи розміщення точкових об’єктів в моделі GRID. 
27. Модель TIN. 
28. Формати даних в ГІС. 
29. Технології введення даних в ГІС. 
30. Інформація про якість даних. 
31. Типи систем введення даних. 
32. Перетворення вихідних даних: поворот, перенесення, масштабування 

(приклади). 
33. Помилки введення даних. 
34. Координати просторових об'єктів. Системи координат в ГІС. 
35.  Географічна система координат. 
36. Системи координат проекцій. Типи картографічних проекцій. 
37. Типи карт. Масштаб карт. 
38. Основи дистанційного зондування Землі (ДЗЗ). 
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39. Джерела супутникових знімків. Проект Landsat. 
40. Аналітичні можливості ГІС (ГІС-аналіз). 
41. Аналітичні процедури ГІС. 
42. Картометричні операції. 
43. Операції вибору. 
44. Основи картографічної алгебри. Операції картографічної алгебри. 
45. Локальні операції картографічної алгебри.  
46. Операції сусідства у картографічній алгебрі. 
47. Зональні операції у картографічній алгебрі. 
48. Глобальні операції у картографічній алгебрі. 
49. Статистичний аналіз в ГІС. Функції статистичного аналізу. 
50.  Оверлейний аналіз. Застосування оверлейного аналізу. 
51. Аналіз перетину двох ліній — основна дія оверлейного аналізу.  
52. Булева логіка в оверлейному аналізі. 
53. Мережевий аналіз. Застосування мережевого аналізу. 
54.  Структура мережевої моделі просторових даних. 
55. Завдання мережевого аналізу. 
56. Пошук найкращого маршруту в Network Analyst. 
57. Побудова буферних зон. 
58. Аналіз просторового розподілу об'єктів. 
59. Операції просторової інтерполяції. Точність інтерполяції. 
60. Методи інтерполяції. 
61. Локально-детерміновані методи інтерполяції. 
62. Побудова полігонів Тиссена-Вороного. 
63. Метод середнього зважування обернено пропорційно до відстані. 
64. Одинарний та регресійний крігінг. 
65. Сплайн-інтерполяція. Переваги і недоліки сплайн-інтерполяції 
66. Технологія побудови цифрових моделей рельєфу. Етапи створення 

ЦМР. 
67. Програмне забезпечення ГІС. 
68. Програмні продукти ESRI. 
69. Структура ArcGIS. Самостійні та додаткові модулі ArcGIS. 
70. Прикладні питання ГІС. 
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